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Welcome to This Guide
This guide describes how to use the HP SOA Systinet Customization Editor to edit the SDM configuration
and the user interface of an installation of SOA Systinet. You can use the Customization Editor to modify
the model, its registry mappings and certain UI elements.

How This Guide is Organized
This guide explains how to use the Customization Editor to create an extension to the configuration of HP
SOA Systinet, how to configure the individual elements of SOA Systinet and then deploy them to an
installation of SOA Systinet.

The guide explains:

Getting Started on page 13. Introducing and configuring the Customization Editor, its main features, and
the customizable elements of SOA Systinet.

Manipulating Artifact Types on page 33. Customizing the attributes, properties and appearance of artifacts.

Manipulating Properties on page 51. Creating and modifying properties and property groups.

Configuring the SOA Systinet UI on page 65. Customizing the main tabs of SOA Systinet and creating new
UI elements.

Modifying Taxonomies on page 83. Modifying the set of available taxonomies.

Deploying an Extension to SOA Systinet on page 85. Preparing and deploying your extension to SOA
Systinet.

User Interface Reference on page 89. A guide to the Customization Editor user interface.
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Document Conventions
The typographic conventions used in this document are:

Script name or other executable command plus mandatory arguments.run.bat make

A command-line option.[--help]

A choice of arguments.either | or

A command-line argument that should be replaced with an actual value.replace_value

A choice between two command-line arguments where one or the other is
mandatory.

{arg1 | arg2}

Operating system commands and other user input that you can type on the
command line and press Enter to invoke. Items in italics should be replaced
by actual values.

rmdir /S /Q System32

Filenames, directory names, paths and package names.C:\System.ini

Program source code.a.append(b);

An inline Java or C++ class name.server.Version

An inline Java method name.getVersion()

A combination of keystrokes.Shift-N

A label, word or phrase in a GUI window, often clickable.Service View

Menu choice.New->Service
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Documentation Updates
This manual's title page contains the following identifying information:

• Software version number

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.-
com/managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web site and use
the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products formerly produced
by Mercury, we encourage you to visit the Mercury Customer Support Web site at: http://support.-
mercury.com.

• For the latest information about support processes and tools available for products formerly produced
by Systinet, we encourage you to visit the Systinet Online Support Web site at: http://www.systinet.-
com/support/index.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

www.hp.com/managementsoftware/services

HP Software online support provides an efficient way to access interactive technical support tools. As a
valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts
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• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To find more information about access levels, go to: www.hp.-
com/managementsoftware/access_level

To register for an HP Passport ID, go to: www.managementsoftware.hp.com/passport-registration.html
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1 Getting Started

The Customization Editor is used to create extensions to the core SOA Systinet configuration. The core
configuration itself is not modified. Instead, SOA Systinet includes a utility for adding extensions to the
configuration.

This chapter describes:

• Introduction to the Customization Editor on page 14 gives an overview of the use of the Customization
Editor.

• Customizable Elements of SOA Systinet on page 15 describes the elements of SOA Systinet that are
configurable using the Customization Editor.

• Creating an Extension Project on page 21 describes how to start a new project to configure SOA Systinet.

• Introduction to the User Interface on page 23 explains the main features of the Customization Editor
user interface.

• Navigating the Customization Editor on page 25 describes the layout of the Extension Explorer – the
main navigation view in the editor.

• Customization Editor Menu Options on page 29 describes the Customization Editor options in the
Eclipse drop-down menus.

• Searching the Extension on page 30 explains how to use the search function to find elements in the
extensions.
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Introduction to the Customization Editor
SOA Systinet is distributed with a preconfigured data model and user interface. For typical deployment
scenarios, both need to be customized to fit an organization specific environment.

HP Systinet provides a mechanism to customize both the model and the appearance of the user interface,
implement those changes and keep them isolated in a so-called extension package that can then be re-applied
during a re-installation or upgrade of SOA Systinet.

The overall process of customizing SOA Systinet is as follows:

1 Use the Customization Editor to:

• Modify the data model and user interface as described in:

• Manipulating Artifact Types on page 33

• Manipulating Properties on page 51

• Configuring the SOA Systinet UI on page 65

• Modifying Taxonomies on page 83

• Save your modifications to a stand-alone extension package file as described in Exporting the
Extension Project on page 85.

2 Use the Setup Tool provided with SOA Systinet to apply the extension package to an installation of
SOA Systinet as described in Applying Extensions on page 86.

Special care must be taken when modifying artifacts that already have instances in the repository.
For example, a new installation already contains the person artifact administrator. Removing
properties from an artifact type with instances or adding a new required property without a default
value may cause instability in SOA Systinet. The Customization Editor should prevent this if the
SOA Systinet server is running during modification.
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Customizable Elements of SOA Systinet
The Customization Editor enables you to modify almost any aspect of an installation of SOA Systinet.
These aspects consist of two main groups:

• SDM Entities are the building blocks that represent the types of entity that exist in the repository defined
by the SOA Definition Model. These are described in more detail in SDM Elements on page 16.

• UI Entities are the elements of the SOA Systinet user interface. These are described in UI Elements on
page 17.
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SDM Elements

The Customization Editor deals with four types of entity in the SDM configuration of SOA Systinet:

• Artifacts are the basic building blocks of SOA. Every entity in the repository is an instance of an artifact.
Each type of artifact is defined by an artifact type in the SDM. Artifact types are further categorized
into artifact packages. These packages are abstract artifact types that do not have instances in the
repository but instead define groups of artifacts.

Artifact types and packages are visible in the Artifact Types branch of the Extension Explorer (see
Artifact Types on page 26) and artifact type procedures are described in Manipulating Artifact Types
on page 33.

• Properties are the attributes of artifacts. Properties are the labels that distinguish one instance of an
artifact from another. For example, all artifact instances have the name property descriptor but every
artifact has a different name.

Properties are visible in the SDM Details branch of the Extension Explorer (see SDM Details on page
27) and property procedures are described in Manipulating Properties on page 51.

• Property Groups enable property descriptors to be organized and added to artifacts as a group instead
of individually. For example; name, address, and telephone number could be organized into a contact
details property group and then whenever a new artifact type is created that represents a person, the
group can be added to it instead of the individual properties.

Property Groups are visible in the SDM Details branch of the Extension Explorer (see SDM Details
on page 27) and property group procedures are described in Manipulating Properties on page 51.

• Taxonomies are categorization groups that each contain a set of values within a single category. For
example, office location could be a taxonomic group containing a set of values representing each office
in an organization.

Taxonomies are visible in the Taxonomies branch of the Extension Explorer (see Taxonomies on page
29) and taxonomy procedures are described in Modifying Taxonomies on page 83.
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UI Elements

Two types of SOA Systinet pages are configurable:

• The main SOA Systinet tabs.

• The artifact detail and browse pages.

The main SOA Systinet tabs consist of the tab heading, a menu on the left and a set of portlets in the main
area of the screen:

Figure 1. SOA Systinet Tab
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The two configurable elements on SOA Systinet tabs are:

• Navigation Menu

The navigation menu is organized into navigation groups and actions.

The details for each SOA Systinet tab are accessible in the User Interface->SOA Systinet tab->Navigation
branch of the Extension Explorer (see User Interface on page 28).

All the navigation actions in your extension are accessible in the User Interface->UI Details-
>Navigation Actions branch in the Extension Explorer (see User Interface on page 28).

Configuring the navigation actions of a SOA Systinet tab, creating and modifying navigation actions,
and organizing navigation actions into groups are described in Configuring the SOA Systinet UI on
page 65.

• Portlets and Feeds

SOA Systinet tabs contain portlets in the main area of the screen.

The details for each SOA Systinet tab are accessible in the User Interface->SOA Systinet tab->Portlets
branch of the Extension Explorer (see User Interface on page 28).

All the portlets in your extension are accessible in the User Interface->UI Details->Portlets Definitions
branch in the Extension Explorer (see User Interface on page 28).

Configuring the portlets of a SOA Systinet tab and creating new portlets are described in Configuring
the SOA Systinet UI on page 65.
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Artifact pages consist of the page heading, a set of contextual menus and the main layout of the page:

Figure 2. SOA Systinet Artifact Page

The two configurable elements on artifact pages are:

• Contextual Action Menus

The contextual menus are organized into UI groups and contextual actions.

The details for each artifact type are accessible in the Service Catalog UI and Tools UI tabs of the
relevant artifact editor (see Artifact Types on page 26).
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All the contextual actions and groups of actions in your extension are accessible in the User Interface-
>UI Details->Contextual Actions and Contextual Action Groups branches in the Extension Explorer
(see User Interface on page 28).

Configuring the contextual menus of an artifact page is described in Manipulating Artifact Types on
page 33. Creating context actions and organizing them into groups is described in Configuring the SOA
Systinet UI on page 65.

• Page Layout

The page layout of artifact detail pages can be configured.

The details for each artifact type are accessible in the Service Catalog UI and Tools UI tabs of the
relevant artifact editor (see Artifact Types on page 26).

Configuring the layout of an artifact page is described in Manipulating Artifact Types on page 33.

Chapter 120



Creating an Extension Project
The first step in customizing your installation is to create an extension project in the Customization Editor.
This is your workspace where you make all your modifications.

To create an extension project:

1 In the File menu, select New–>HP SOA Systinet Extension Project.

2 Complete the dialog with parameters:

DefinitionParameter

Select the location of the extension folder in your SOA Systinet
installation using Browse.

Extension Folder

The URL used to access SOA Systinet in the form -
http://localhost:8080/soa

Server URL

Click Next to select the working extension:

3 Select one of the three options:

• Create a new extension project from scratch – this creates an empty extension containing no elements
at all.

• Edit an existing extension – open an extension for modification.

• Create a new extension from an existing one – use an existing extension as the basis of a new one.

For the last two options select an extension from the extension folder or use Add Extension to select
one from another location.

Click Next.

Edit extension skips to step 6.
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4 For the create options complete the dialog with parameters:

DefinitionParameter

The name of your extension projectName

The prefix used for the URI when creating a new artifact type or propertyNamespace

A description of your extension projectDescription

The extension version numberVersion

The identifier for the resource in the configurationURI

Click Next to select an extension dependency.

5 For the create options you can optionally add dependencies on other extensions. By default, all
extensions are dependent on the core extension.

Select an extension from the list or use Add extension to add an extension from outside the default
extensions directory to the list. Click Next to set the extension properties.

6 Complete the dialog with the following parameters:

DefinitionParameter

The ID of the new extension projectProject Name

Optionally, uncheck Default Location and use Browse to select a new workspace
directory

Location

7 Click Finish to create the project.

The Extension Explorer (see Navigating the Customization Editor on page 25) now displays a view of
your extension which contains not only the elements contained in the extension but all the elements from
any other extensions that your project depends on.
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Introduction to the User Interface
The user interface is split into three sections with menu options across the top. On the left is a tree view of
the SDM configuration. The main section contains the details of the item highlighted on the left. Multiple
editors can be open in this main section and the functionality varies depending on the editor. In the bottom-
right are views for tracking problems, actions, and searches.

Figure 3. Customization Editor UI
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The details of the user interface are described in:

• Navigating the Customization Editor on page 25. The Extension Explorer is the main navigation view
for the Customization Editor.

• User Interface Reference on page 89 describes the functionality of each editor and view in the main and
bottom-right sections.
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Navigating the Customization Editor
The Extension Explorer represents a tree view of the extension project that you are currently working
with. It includes all the elements from extensions that it depends on as well.

Figure 4. Extension Explorer View

Double-clicking an item in the tree will open the relevant editor in the main section and also open/close a
branch.
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Right-clicking an element opens a context menu of options relevant to the particular element.

The tree is split into the extension root and five branches representing different elements of your extension.
The functionality within each element is described in the following sections:

• Your Extension on page 26 describes the top level object in the extension.

• Artifact Types on page 26 contains the hierarchical structure of the artifact types and packages within
the extension.

• SDM Details on page 27 contains properties and property groups.

• User Interface on page 28 contains the customizable elements of the SOA Systinet user interface.

• Taxonomies on page 29 accesses the categorization groups available within this extension.

• project.xml on page 29 is configuration of the current extension project.

Your Extension

The extension name is the root element of the project.

The right-click context menu contains the option to Export Extension which creates a jar containing your
extension ready to import to SOA Systinet (see Deploying an Extension to SOA Systinet on page 85).

Artifact Types

The Artifact Types branch contains the artifact types organized into a hierarchical structure reflecting the
SOA Model.

Each element below Artifact Types is a type of artifact and the right-click context menu has the following
functionality:

• New Artifact Type/Package creates a new artifact type as described in Creating a New Artifact Type
or Package on page 34.

• Open Artifact Type/Package opens the artifact editor for the selected element with the name of the
element as the editor title. The functionality of this view is described in Artifact Editor on page 90.
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• Deprecate Artifact Type/Package. After confirmation, the artifact type becomes inactive in the extension
project and is hidden in the SOA Systinet UI.

• Undeprecate Artifact Type/Package. After confirmation, the artifact type reactivates in the extension
project.

• Delete Artifact Type/Package. After confirmation, the artifact type is removed from the extension
project.

An artifact package is an artifact type that serves a group of other artifacts. They do not have
instances in the repository and just serve to organize a hierarchy of artifact types in the SDM.

SDM Details

The SDM Details branch contains two element types:

• Property Descriptors of which there are three types:

• Primitive Property

• Relationship Property

• Taxonomy Property

The parent branches contain one context menu option:

• New Property opens a dialog described in Creating a New Property on page 52.

Within each parent element is the list of properties of that type. The context menu for properties contains
the following options:

• Open Property opens the property editor for the selected element with the name of the element as
the editor title. The functionality of this view is described in Property Editor on page 103.

• Deprecate Property. After confirmation, the property becomes inactive in the extension project
and is hidden in the SOA Systinet UI.

• Undeprecate Property. After confirmation, the property reactivates in the extension project.

• Delete Property. After confirmation, the property is removed from the extension project.
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• Find Usage opens a search view displaying all the artifacts and property groups that contain this
property as described in Search View on page 124.

• Property Groups

The context menu of the parent element only has one option:

• New Property Group opens a dialog described in Creating a New Property Group on page 63.

The context menu for each property group has these options:

• Open Property Group opens the property group editor for the selected element with the name of
the element as the editor title. The functionality of this view is described in Property Group Editor
on page 107.

• Delete Property Group. After confirmation, the property group is removed from the extension
project.

• Find Usage opens a search view displaying all the artifacts that contain this property group as
described in Search View on page 124.

User Interface

The User Interface branch contains a branch for each tab in the SOA Systinet UI and a UI Details branch
containing UI elements.

The branch for each SOA Systinet tab contains two elements:

• Navigation. Double-click to open the view for that SOA Systinet tab allowing you to customize the
menus in SOA Systinet. The functionality of the Navigation editor is described in Navigation Editor
on page 109.

• Portlets. Double-click to open the view for that SOA Systinet tab allowing you to customize the portlets
that are available on the selected SOA Systinet tab. The functionality of the Portlets editor is described
in Portlets Editor on page 111.
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UI Details contains five elements:

• Contextual Action Groups allow you to group context actions together and add them to the context
options in the SOA Systinet UI. Double-click to open the view described in Contextual Action Groups
Editor on page 113 or right click and select New Context Action Group to start the dialog described in
Creating a New Context Action Group on page 76.

• Contextual Actions are options available within artifact and service pages in the SOA Systinet UI.
Double click to open the view described in Contextual Actions Editor on page 115 or right click and
select New Context Action to start the dialog described in Creating a New Contextual or Navigation
Action on page 72.

• Navigation Actions are the links in SOA Systinet that navigate between pages. Double click to open
the view described in Navigation Actions Editor on page 116 or right click and select New Navigation
Action to start the dialog described in Creating a New Contextual or Navigation Action on page 72.

• Perspectives control the views available to users in SOA Systinet. Double click to open the view
described in Perspectives Editor on page 117 or right click and select New Perspective to start the dialog
described in Creating a New Perspective on page 79.

• Portlets Definitions are the components in the main section of SOA Systinet pages. Double click to
open the view described in Portlets Definitions Editor on page 118 or right click and select New Portlet
to start the dialog described in Creating a New Portlet on page 80.

Taxonomies

The Taxonomies branch allows you to control the taxonomies that are available within your extension
project. Double-click to open the view described in Taxonomies Editor on page 119.

project.xml

The project.xml branch accesses the view allowing you to configure the current extension project as
described in project.xml Editor on page 120.

Customization Editor Menu Options
The menus in Customization Editor are the normal Eclipse menus with the addition of specific functionality
for the Customization Editor.
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The extra menu options in the Customization Editor include:

• File->New->HP SOA Extension Project to start a new project as described in Creating an Extension
Project on page 21.

• File->New->Artifact Type to create a new artifact type as described in Creating a New Artifact Type
or Package on page 34.

• File->New->Artifact Package to create a new artifact package as described in Creating a New Artifact
Type or Package on page 34.

• File->New->Property to create a new property as described in Creating a New Property on page 52.

• File->New->Property Group to create a new property group as described in Creating a New Property
Group on page 63.

• Navigate->Go To->Open Artifact to open an artifact editor as described in Artifact Editor on page
90.

• Navigate->Go To->Open Property to open a property editor as described in Property Editor on page
103.

• Navigate->Go To->Open Property Group to open a property group editor as described in Property
Group Editor on page 107.

• Search->Search opens a search dialog as described in Searching the Extension on page 30.

• Help->Dynamic Help accesses context sensitive help, directing you to the relevant section of this
document based on the active view in the Customization Editor.

Searching the Extension
The Customization Editor contains a customized search function that enables you to find entities in the
extension.

To search the extension:

1 In the Search menu select Search to open the Search dialog:
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2 Complete the SDM search dialog containing parameters:

DefinitionParameter

The parameter to search the extension forContaining text

Check the box to make the search case sensitiveCase sensitive

Allows more sophisticated search parameters. For example, to find
everything with more than one word. This is an advanced topic beyond the
scope of this guide.

Regular expression

Select the SDM entities to searchSearch For

Select the entity attributes to searchSearch In

Select the extension to searchScope

3 Click Search to execute the search and view the results in the Search view (see Search View on page
124).
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Saving Modifications
As you modify an entity in your extension project the tab label of the entity editor is marked with an asterisk.

To save your changes to the project select File->Save from the File menu.

If you close an editor or the application with unsaved changes you are prompted to save these changes.

These changes are made to your extension project and not to the configuration of SOA Systinet. To deploy
your modifications to SOA Systinet see Deploying an Extension to SOA Systinet on page 85.
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2 Manipulating Artifact Types

The Customization Editor can be used to create, modify and delete artifact types in your extension project.
You can also change the format of artifact pages in the SOA Systinet UI.

The chapter describes the following procedures:

• Creating a New Artifact Type or Package on page 34

• Modifying the Attributes of an Artifact Type on page 38

• Modifying the Properties of an Artifact Type on page 39

• Modifying an Artifact Type in the Services UI on page 40

• Modifying an Artifact Type in the Tools UI on page 40

• Modifying the Layout of the View Artifact Page on page 41

• Modifying the Contextual Actions of an Artifact on page 44

• Mapping an Artifact Type to a Registry on page 47
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Creating a New Artifact Type or Package
This procedure describes how to create a new artifact type or package in your extension project. For more
information on artifact types and packages, see SDM Elements on page 16.

To create a new artifact type:

1 To start the New Artifact Type dialog:

• In the File menu select New->Artifact Type/Package.

• Alternatively, in the Extension Explorer right-click Artifact Types and select New Artifact
Type/Package.

• Alternatively, in the Extension Explorer right-click an artifact package branch and select New
Artifact Type/Package to create a new artifact type as part of that package.

The New Artifact Type or New Artifact Package dialog appears:
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2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The name of the artifact as it is stored in the extensionLocal Name

The identifier for the resource in the configurationURI

The plural name of the artifact as it appears in the SOA Systinet UICollection Display
Name

A browse button allows you to select the parent artifact type that this artifact
type belongs to

Package

A browse button allows you to select an artifact type to inherit the properties
from

Extends

The description of the artifact type as it appears in the SOA Systinet UIDescription
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3 Do one of the following:

• Click Finish to create the artifact type.

• Continue to Step 4 to set the visibility of the artifact in the SOA Systinet UI.

4 Click Next.

The New Artifact Type/Package displays visibility parameters:
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5 Complete the dialog which contains the following parameters:

DefinitionParameter

If the new artifact type extends an artifact with an existing UI configuration
check the box if you want it to inherit these attributes

Copy User Interface
configuration from
parent artifact type?

Check the box if the artifact type is visible in the Service UIIs the artifact available
in Service Catalog?

Use Add and Remove to select viewing permissions in the SOA Systinet
UI

Visible to

Use Add and Remove to select edit permissions in the SOA Systinet UIEditable by

6 Do one of the following:

• Click Finish to create the artifact type.

• Continue to Step 7 to set database parameters.

7 Click Next.

The New Artifact Type/Package displays database settings.

These settings cannot be changed if the new artifact extends an artifact type that already
defines them.

Complete the dialog which contains the following parameters:

DefinitionParameter

The name of collection where the artifact instances are storedCollection name

The name of the database table where instances of this artifact are storedDatabase table
name

8 Click Finish to create the artifact type.
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Modifying the Attributes of an Artifact Type
To edit the main attributes of an artifact type:

1 Open the artifact editor in the General tab.

2 The General tab displays three editable segments:

• Artifact General Information contains four editable parameters:

DefinitionParameter

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The plural version of the name as it appears in the SOA Systinet UICollection
Display Name

The description of the artifact type as it appears in the SOA Systinet UIDescription

A checkbox indicating whether the artifact is currently active in the extensionDeprecated

• Visible to

Use Add and Remove to select the perspectives that can see this artifact type within SOA Systinet.

• Editable by

Use Add and Remove to select the perspectives that can amend this artifact type within SOA
Systinet.
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Modifying the Properties of an Artifact Type
To add or modify the properties and property groups of an artifact type:

1 Open the artifact editor and click the Properties tab.

2 The Properties tab contains two modifiable segments:

• Properties:

• Click New to create a new property as an attribute of the artifact type and create the property
as described in Creating a New Property on page 52.

• Click Add to select a property to add to the artifact type with a selected cardinality and Tools
UI appearance option.

• Click Deprecate to deactivate the property in the artifact type.

• Click Undeprecate to reactivate a deprecated property in the artifact type.

• Select a property and click Remove to remove the property from the artifact type.

• Property Groups:

• Click New to create a new property group as a set of attributes of the artifact type as described
in Creating a New Property Group on page 63.

• Click Add to add a property group to the artifact type.

• Select a property group and click Remove to remove the group from the artifact type.
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Modifying an Artifact Type in the Services UI
To configure the appearance of an artifact type in the View Artifact page in the Services UI:

1 Open the artifact editor and click the Service Catalog UI tab.

2 Check the Is artifact available in Service Catalog? box to make the artifact type visible in the Services
UI.

3 If the artifact type is available in the Service UI there are two elements of the View Artifact page that
can be modified:

• To modify the layout of the View Artifact page see Modifying the Layout of the View Artifact
Page on page 41.

• To modify the contextual actions in the View Artifact page see Modifying the Contextual Actions
of an Artifact on page 44.

Modifying an Artifact Type in the Tools UI
To modify the appearance of an artifact type in the View Artifact and Browse Artifact pages of the Tools
UI:

1 Open the artifact editor and click the Tools UI tab.

2 There are two elements of the View Artifact and Browse Artifact pages in the Tools UI that can be
modified:

• To modify the layout of the View Artifact page see Modifying the Layout of the View Artifact
Page on page 41.

• To modify contextual actions in the View Artifact page or the Browse Artifact page see Modifying
the Contextual Actions of an Artifact on page 44.
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Modifying the Layout of the View Artifact Page
The View Artifact page shows the details of an artifact in both the Services and Tools tabs of SOA Systinet.
The elements that appear there can be modified with the Customization Editor.

To modify the layout:

1 Open the artifact editor and click the Service Catalog UI or Tools UI tab according to which view
you want to modify.

2 In the Layout segment:

• To change the order of elements, select the element and click Up and Down.

• To remove an element select it and click Remove.

• To edit an element select it, click Edit and modify the same parameters as appear in the Add
functions.

• To add an element click Add:

• To add a new layout heading, in which to group properties and components, select Group,
input a name for the group and click Finish to add it to the layout.
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• To add a property:

a Select Property and click Next to open the Layout Property Details dialog:

b Complete the dialog with the following parameters:

DefinitionParameter

Select one of the properties to be displayed in the layoutProperty

Select the layout heading that the property is part ofLayout Group

Use Add and Remove to select the perspectives that can see the
property

Visible to

Use Add and Remove to select the perspectives that can edit the
property

Editable by
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c Click Finish to add the property to the layout.

• To add a new functional UI component:

a Select Component and click Next to open the Layout Component Details dialog:

b Complete the dialog with the following parameters:

DefinitionParameter

The name of the component as it appears in the SOA Systinet UIComponent
Name

Select the layout heading that the component is part ofLayout Group

Use Add and Remove to select the perspectives that can see the
component

Visible to

Use Add and Remove to select the perspectives that can edit the
component

Editable by

c Click Finish to add the component to the layout.
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This component must also be created using an external development tool and
implemented in the UI configuration. See Known Issues in readme/readme_eclipse.html
in the Customization Editor installation directory for more details.

Modifying the Contextual Actions of an Artifact
At the top of the View Artifact page in both Services and Tools and the Browse Artifact page in Tools
is a section containing sets of Contextual Actions. The actions that appear there can be modified with the
Customization Editor.

To modify the contextual actions in these pages:

1 Open the artifact editor and click the Service Catalog UI or Tools UI tab according to which view
you want to modify.

2 In the Contextual Actions segment:

In the Tools UI tab this segment contains two tabs:

• Artifact Detail refers to the View Artifact page.

• Collection refers to the Browse Artifact page.

• To change the order of actions, select the action and click Up and Down.

• To remove an action select it and click Remove.

• To edit an action element select it, click Edit and modify the same parameters as appear in the
Add functions.

• To add an action element click Add:

• To add a contextual menu heading select UI Group, input a display name for the group and
click Finish to add it to the context menu.
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• To add a contextual action item:

a Select Contextual action item and click Next to open the Contextual Action Item Details
dialog:

b Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

The description of the context actionDescription

Select the action from the listAction

Select the action menu that the action is part ofUI Group

Use Add and Remove to select the perspectives that can see the
property

Visible to

Additional parameters if required by the action itemParameters
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c Click Finish to add the element to the context action menu.

• To add a set of contextual actions to the menu:

a Select Contextual action group reference and click Next to open the Group reference
detail dialog.

b Select the Contextual action group for the required set of actions and the UI group that
the actions appears in and click Finish to add the set of actions to the contextual menus.
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Mapping an Artifact Type to a Registry
Artifacts in SOA Systinet can be mapped to registry entities in a UDDI registry.

The following artifact types have predefined mappings to registry and cannot be amended:

Table 1. Predefined Registry Mapping

DirectionUDDI entitySDM artifact

Bi-directionalBusinessEntityOrganizational Unit

Bi-directionaltModelBusiness Service

Bi-directionalBusiness ServiceImplementation Artifacts

Bi-directionalBindingTemplateEndpoint

Figure 1 illustrates the mapping of an artifact to a registry entity:

Figure 1. Registry Mapping
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To add or modify artifact type mappings to registry entities:

1 Open the artifact editor and click the Registry Mapping tab.

2 The functionality of the Artifact Mapping segment and Property Mapping is the same:

• To edit a mapping, select the mapping, click Edit and modify the same parameters as appear in
the Add functionality.

• To remove a mapping select the mapping and click Remove.

• To add a registry mapping for an artifact type:

a In the Artifact Mapping segment click Add to open the New Artifact Mapping dialog:
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b Complete the dialog with the following parameters:

DefinitionParameter

Use Select to select from the available registriesRegistry

Use Add to select from the available taxonomies or input oneT-ModelKey

If you are mapping to a UDDI version 2 registry input a taxonomy keyT-ModelKey
version 2

The name used to categorize the UDDI entity in the registryKey Name

The value used to categorize the tModel in the registryKey Value

The name of the mapping as it appears in the SOA Systinet UIDisplay Name

If selected, the content of documents referenced from the UDDI entity
are cached in SOA Systinet

Cache content

Select the direction of the mapping from the drop-down listDirection

c Click Finish to add the mapping.

• To add a registry mapping for a property:

a In the Property Mapping segment click Add to open the New Property Mapping dialog:
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b Complete the dialog with the following parameters:

DefinitionParameter

Use Select to select from the available propertiesProperty

Select the direction of the mapping from the drop-down listDirection

Use Select to select from the available registriesRegistry

Use Add to select from the available taxonomies or input oneT-ModelKey

If you are mapping to a UDDI version 2 registry input a taxonomy keyT-ModelKey
version 2

The name used to categorize the UDDI entity in the registryKey Name

c Click Finish to add the mapping.
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3 Manipulating Properties

The Customization Editor enables you to create, modify and delete properties and property groups in your
extension project.

The property procedures are:

• Creating a New Property on page 52 describes how to create properties of types:

• Primitive

• Relationship

• Taxonomy

• Modifying a Property on page 60

• Creating a New Property Group on page 63

• Modifying a Property Group on page 64

Manipulating Artifact Types on page 33 includes these procedures which are also related to properties:

• Modifying the Properties of an Artifact Type on page 39 describes how to add properties to an artifact.

• Mapping an Artifact Type to a Registry on page 47 describes how to add registry mappings to an artifact
and its properties.
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Creating a New Property
This procedure describes how to create a new property descriptor in your extension project. For more
information on properties, see SDM Elements on page 16.

To create a new property:

1 To start the New Property dialog:

• In the File menu select New->Property.

• Alternatively, in the Extension Explorer right-click Property Descriptors and select New Property
and the property type.

• Alternatively, in the Extension Explorer right-click a property type branch and select New Type
Property to create a property of that type.

The New Property dialog appears.
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2 A different dialog opens depending on the property type:

• For primitive properties:
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Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the resource in the configurationURI

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Use Browse to select a property from the available primitive property
types

Property Type
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• For relationship properties which are created in pairs:
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Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the resource in the configurationURI

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Select a type from the drop-down listRelation Type

Use Browse to select the source artifact type of the relationshipFrom Artifact

Use Browse to select the target artifact type of the relationshipTo Artifact

The name of the inverse relationship property as it appears in the SOA
Systinet UI

Inverse Display Name

The name of the inverse relationship property as it is stored in the
extension

Inverse Local Name

The identifier for the resource in the configurationInverse URI

The plural name of the inverse relationship property as it appears in the
SOA Systinet UI

Inverse Collection
Display Name

The description of the inverse relationship property as it appears in the
SOA Systinet UI

Inverse Relationship
Description
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• For taxonomy properties:
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Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the resource in the configurationURI

The plural name of the property as it appears in the SOA Systinet UICollection Display
Name

The description of the property as it appears in the SOA Systinet UIDescription

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Use Browse to select a taxonomy from the available taxonomiesTaxonomy

3 Do one of the following:

• Click Finish to create the property.

• Continue to Step 4 to set property visibility.
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4 Click Next.

The New Property dialog displays visibility parameters:

5 Complete the dialog which contains the following parameters:

DefinitionParameter

Use Add and Remove to select viewing permissions in the SOA Systinet UIVisible to

Use Add and Remove to select edit permissions in the SOA Systinet UIEditable by

If you are creating the property as an attribute of an artifact select the layout heading
in which the property appears in the View Artifact page in the tools UI or select
<hidden> if the property is not visible.

Tools UI group

6 Click Finish to create the new property.
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Modifying a Property
To edit a property:

1 Open the property editor.

2 Edit the general attributes of the property in the General tab and the advanced attributes in the Advanced
tab.

• The General tab contains four editable segments:

• General contains four editable parameters:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The description of the property as it appears in the SOA Systinet UIDescription

The plural version of the name as it appears in the SOA Systinet UICollection
Display Name

A checkbox indicating whether the property is currently active in the extensionDeprecated

• There are three types of property and the second segment is specific to each:

• Property Type

Primitive properties are not editable and just display the property type.

• Relationship

Use Add and Remove to select the endpoints of the relationship.

• Taxonomy

Use Browse to select a new taxonomy from the extension project.
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• Visible to

Use Add and Remove to select the perspectives that can see this property within SOA Systinet.

• Editable by

Use Add and Remove to select the perspectives that can amend this property within SOA
Systinet.

• The Advanced tab contains three editable segments:

• Cardinality contains three editable parameters:

DefinitionParameter

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

For multiple cardinality enter a minimum number of instances of the propertyMinOccurs

For multiple cardinality enter a maximum number of instances of the property.
Use unbounded if there is no limit.

MaxOccurs

61Manipulating Properties



• Default Values contains two editable parameters:

DefinitionParameter

Default value is described by an XML element which must follow the rules
defined by XML schema for the selected property and property type. For
example, a primitive plain text property with local name email is defined
by

<p:email 
xmlns:p="http://systinet.com/2005/05/soa/model/property">value</p:email>

Default Value

If the property has multiple cardinality then specify more than one default
value. For example, a plain text property with local name email and multiple
cardinality is defined by

<g:emailGroup
    xmlns:g="http://systinet.com/2005/05/soa/model/propertyGroup"
    xmlns:p="http://systinet.com/2005/05/soa/model/property">
  <p:email>value1</p:email>
  <p:email>value2</p:email> 
</g:emailGroup>

Multiple Default
Value

• Database Sizes enables you to optionally set the storage size of property elements with Add,
Edit and Remove functionality.

Chapter 362



Creating a New Property Group
As many artifacts share sets of the same properties it is useful to create groups of properties and add these
to the artifacts instead.

To create a new property group:

1 To start the New Property Group dialog:

• In the File menu select New->Property Group.

• Alternatively, in the Extension Explorer right-click Property Groups and select New Property
Group.

• Alternatively, in the artifact Properties tab click New in the Property Groups segment to create
a new group as a set of attributes for an artifact type.

The New Property Group dialog appears:
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2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the property group as it appears in the SOA Systinet UIDisplay Name

The identifier for the resource in the configurationURI

Use Add and Remove to select the properties in the groupProperties

3 Click Finish to create the property group.

Modifying a Property Group
To edit a property group:

1 Open the property group editor.

2 Modify the property group with one of the following functions:

• Edit the General segment to change the display name of the property group.

• Click New under Properties to create a new property as part of the group as described in Creating
a New Property on page 52.

• Click Add to add a property to the group from the list of available properties.

• Click Remove to remove a property from the group.
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4 Configuring the SOA Systinet UI

The main tabs in SOA Systinet can be modified and also the appearance of artifact pages can be altered
using the Customization Editor

The procedures for altering the appearance of artifact pages are in Manipulating Artifact Types on page 33.
This section deals with creating and modifying UI elements and modifying the appearance of the main SOA
Systinet tabs.

The available procedures are:

• Adding Portlets to a SOA Systinet Tab on page 66. 

• Adding Navigation Groups to a SOA Systinet Tab on page 68. 

• Adding Navigation Actions to a SOA Systinet Tab on page 69. 

• Adding Components to a SOA Systinet Tab on page 71. 

• Creating a New Contextual or Navigation Action on page 72. 

• Modifying a Contextual or Navigation Action on page 75. 

• Creating a New Context Action Group on page 76. 

• Adding Context Actions to a Group on page 77. 

• Creating a New Portlet on page 80. 

• Creating a New RSS Feed Portlet on page 81. 

• Creating a New Perspective on page 79. 
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Adding Portlets to a SOA Systinet Tab
The Customization Editor can be used to configure the portlets that are available in each tab in SOA Systinet
and where they appear on the tab.

To add portlet to a SOA Systinet tab:

1 Open the Portlets editor for the SOA Systinet tab you want to modify.

2 Click Add to open the New Portlet Placement dialog:
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3 Complete the dialog which contains the following parameters:

DefinitionParameter

Click Browse to select from the available portletsPortlet Reference

The name of the portlet as it appears in the SOA Systinet UIDisplay Name

There are two options:

• Page. The portlet is open in the main area of the SOA Systinet tab

• Menu. The portlet is closed but available to add in the left menu

Location

If the portlet is located on the page then use the drop-down list to select which
column it appears in

Column

If Menu is selected check this box to enable multiple instances of the portlet.Permanent

Use Add and Remove to select the perspectives that can see the portletVisible to

4 Click Finish add the portlet to the SOA Systinet tab.
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Adding Navigation Groups to a SOA Systinet Tab
The Customization Editor can be used to configure the menu in each SOA Systinet tab. The items in the
menu are organized into groups and these groups can be added to the menu instead of individual items.

To add a navigation group to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type dialog.

3 Select Group and click Next to open the Group Details dialog.

4 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the group heading as it appears in the SOA Systinet UIGroup Name

A description of the new navigation groupDescription

5 Click Finish add the group to the SOA Systinet tab menu.
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Adding Navigation Actions to a SOA Systinet Tab
The Customization Editor can be used to configure the menu in each SOA Systinet tab. Each item in the
menu corresponds to a navigation action linking to another page in SOA Systinet.

To add a navigation item to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type dialog.

3 Select Item and click Next to open the Menu Item dialog:
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4 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the navigation link as it appears in the SOA Systinet UIItem Name

Select the Navigation Action from the drop-down listAction ID

Select the menu heading that the item is part of from the drop-down listGroup Name

A description of the new navigation itemDescription

Use Add and Remove to select the perpectives that can see the itemVisible to

5 Click Finish add the item to the SOA Systinet tab menu.
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Adding Components to a SOA Systinet Tab
The Customization Editor can be used to configure the left-menu in each tab in SOA Systinet. Some items
in the menu are links to a component that performs specific functionality.

To add a component to a SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type dialog.

3 Select Component and click Next to open the Component Details dialog:

4 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the componentComponent Action

Select the menu heading that the component is part of from the drop-down listGroup Name

Use Add and Remove to select the perspectives that can see the componentVisible to

5 Click Finish add the component to the SOA Systinet tab menu.
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Creating a New Contextual or Navigation Action
Contextual and navigation actions are both links to pages in SOA Systinet

To create a new action:

1 To open the New Action dialog:

• Right-click the Contextual Actions or Navigation Actions branch in the Extension Explorer
and select New Type Action.

• Alternatively, click New in the Contextual Actions or Navigation Actions editor.

The New Action dialog appears:
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2 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the contextual or navigation actionAction ID

The name of the action that for:

• Contextual actions – renders this link in the context actions menus

• Navigation actions – is called when the user clicks the link

Task Location

Use Add and Remove to select the task parameters for the navigation or
contextual action specified in Task Location which consist of:

• Key. The name of the parameter

• Value. The value of the parameter

Task Parameters

The name of the SSO partnerPartner

A relative URL pointing to the resource, that is accessed via SSOPartner Path

3 Click Finish to create the new action.

The full URL is compiled from the base URL retrieved from the DB (where the key is the name
of the SSO Partner) and the relative URL.

If SSO is not needed to render the context action / menu item, then only the task location and task parameters
are used. If SSO is required (the context action or menu item references a task/resource in a different product
than it is rendered in) then the target URL is composed from partner, partner path and task parameters.

73Configuring the SOA Systinet UI



For example:

    <action id="tools.newOther">
      <partner>@platform.sso.identity.id</partner>
      <partnerPath>web/publishing/structuredFile/wizard</partnerPath>
      <task location="/publishing/structuredFile/wizard">
        <parameter key="FirstUIStateID">fileDetails</parameter>
      </task>
    </action>

The SSO URL is composed from e.g. http://johngalt:8080/soa/systinet/platform/ +
web/publishing/structuredFile/wizard + ? + FirstUIStateID=fileDetails to final form
http://johngalt:8080/soa/systinet/platform/web/publishing/structuredFile/wizard?FirstUIStateID=fileDetails
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Modifying a Contextual or Navigation Action
To modify an action:

1 Open the Contextual Actions or Navigation Actions editor according to which type of action you
want to modify.

2 Select the action to modify and click Edit.

3 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the contextual or navigation actionAction ID

The name of the action that for:

• Contextual actions – renders this link in the context actions menus

• Navigation actions – is called when the user clicks the link

Task Location

Use Add and Remove to select the task parameters for the navigation or
contextual action specified in Task Location. The parameters consist of:

• Key. The name of the parameter

• Value. The value of the parameter

Task Parameters

The name of the SSO partnerPartner

The URL pointing to the resource accessed by the actionPartner Path

4 Click Finish to confirm your changes.
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Creating a New Context Action Group
As many artifact types share sets of the context actions it is useful to make groups of actions and add these
to artifact types instead.

To create a new context action group:

1 To open the Contextual Actions dialog:

• In the Extension Explorer right-click the Contextual Action Groups branch and select New
Context Action Group.

• Alternatively, click Add in the Contextual Action Groups editor.

2 Select Group of Contextual Actions and click Next.

3 Input the display name for the group and click Finish to create the contextual action group.
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Adding Context Actions to a Group
As many artifact types share sets of the context actions it is useful to make groups of actions and add these
to artifact types instead.

To add a context action to a group:

1 To open the Contextual Actions dialog:

• In the Extension Explorer right-click the Contextual Action Groups branch and select New
Context Action Group.

• Alternatively, click New in the Contextual Action Groups editor.

2 Select Action Item and click Next to open the Edit Item dialog:
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3 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the context action itemDisplay Name

A description of the itemDescription

Select the action to add from the drop-down listAction

Select the group to add the action to from the drop-down listGroup

Use Add and Remove to select the perspectives that can see the actionVisible to

4 Click Finish add the action to the group.
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Creating a New Perspective
Perspectives control the views of SOA Systinet that are available to each user.

To create a new perspective:

1 To open the New Perspective dialog:

• In the Extension Explorer right-click the Perspectives branch and select New Perspective.

• Alternatively, click New in the Perspectives editor.

The New Perspective dialog appears:

2 Complete the dialog which contains the following parameters:

DefinitionParameter

The name of the perspective in the extension projectPerspective ID

The name of the perspective as it appears in the SOA Systinet UIDisplay Name

The description of the perspective as it appears in the UIDescription

3 Click Finish to create the perspective.
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Creating a New Portlet
Portlets are the components in the main section of SOA Systinet tabs with varying functionality depending
on the portlet.

To create a new portlet:

1 In the Extension Explorer double-click the Portlets Definitions branch to open the Portlets Definitions
editor.

2 Click Add and select Portlet to open the Add Portlet dialog.

3 Input a name and url for the portlet and click Finish to create the portlet.
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Creating a New RSS Feed Portlet
The RSS feed portlets in the main section of SOA Systinet tabs display up-to-date views of repository data
or links to external RSS feeds.

To create a new RSS Feed Portlet:

1 In the Extension Explorer double-click the Portlets Definitions branch to open the Portlets Definitions
editor.

2 Click New and select Feed to open the Add Feed dialog:

3 Complete the dialog which contains the following parameters:

DefinitionParameter

The identification of the portlet definitionPortlet ID

The link to the RSS sourceUrl

The name of the SSO partnerPartner

Check the box to allow multiple instances of the feedMultiple Instances

Click Finish to create the feed.
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5 Modifying Taxonomies

The Customization Editor controls which taxonomies are available in the extension project. You can create
and modify taxonomies using HP SOA Systinet Taxonomy Editor.

To control taxonomies in the extension:

1 In the Extension Explorer double-click Taxonomies to open the Taxonomies editor.

If the SOA Systinet server specified in the Server URL during configuration (see Creating
an Extension Project on page 21) is running then all the taxonomies in SOA Systinet are added
to the list when this editor opens.

2 To modify the available taxonomies in your extension project:

• To import taxonomies from SOA Systinet and add them to the extension click Import.

• To update taxonomies in your extension newer versions from SOA Systinet click Update.

• To remove a taxonomy from the extension, select the taxonomy and click Remove.
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6 Deploying an Extension to SOA
Systinet

HP SOA Systinet Customization Editor does not deploy directly to SOA Systinet. Instead, deploying an
extension to SOA Systinet is a two-part process:

1 Save your new extension project as a jar file in the SOA Systinet extension folder as described in
Exporting the Extension Project on page 85.

2 Deploy the extension to SOA Systinet using the Setup Tool as described in Applying Extensions on
page 86.

Exporting the Extension Project
Customization Editor displays the entire configuration of your extension plus other extensions it depends
on. However, your extension only consists of any modifications and additions that you have made. Only
these changes are stored when you save your project as an extension jar file and only these changes are
deployed to SOA Systinet

To create your extension package:

1 Right-click the extension name in the Extension Explorer (see Navigating the Customization Editor
on page 25and select Export Extension to open the export dialog.

2 By default, the Extension Folder set during configuration (see Creating an Extension Project on page
21) is selected. Choose a save location and file name and click Save.
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Applying Extensions
SOA Systinet can be extended with libraries that are added into the deployed .ear files. The setup tool opens
the .ear files, applies the extensions and repacks the .ear files.

Extensions to SOA Systinet come from the following sources:

• The HP SOA Systinet Customization Editor

• HP SOA Systinet Policy Manager extensions used to create assertions in HP SOA Systinet Assertion
Editor. These extensions are custom validation handlers. You must apply them to the HP SOA Systinet
Policy Manager server in order for HP SOA Systinet Policy Manager to use assertions created with
them.

• Upgrading from the Visibility Edition to the Standard Edition, which requires HP SOA Systinet Policy
Manager and Contract Manager extensions to be added to SOA Systinet.

To apply extensions to SOA Systinet:

1 Make sure that all extensions are in the PLATFORM_HOME/extensions  directory. The setup tool automatically
applies all extensions in that directory.

If you are applying extensions to another server substitute PLATFORM_HOME with the relevant
home directory.

2 Stop the server.

3 Start the setup tool by executing PLATFORM_HOME/bin/setup.bat(sh).

The application server to which SOA Systinet is deployed must not be running.

4 Choose the Apply Extensions scenario and click Next. The setup tool automatically validates the step
by connecting to the server, copying the extensions and merging the SDM configuration.

5 Enter the path to the application server installation requiring the extension and any other parameters
specific to your AS and click Next. The setup tool then confirms this information.
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6 Click Next to complete the process by unpacking the SOA Systinet .ear and .war files, and Next to
merge the SDM and UI configurations, generating all necessary schemas and repacking the .ear and
.war files. Note that this takes some time.

7 Click Finish to end the process.

8 Restart the server.
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7 User Interface Reference

Each Customization Editor view in the main and bottom-right section of the editor is described in the
following sections:

• Artifact Editor on page 90. Manage your SOA artifacts and customize their properties, appearance and
registry mapping.

• Property Editor on page 103. Manage your SOA properties and which perspectives can see and edit them.

• Property Group Editor on page 107. Organize your properties into groups.

• Navigation Editor on page 109. Customize the left-menu navigation links in SOA Systinet tabs.

• Portlets Editor on page 111. Customize which portlets appear in SOA Systinet tabs.

• Contextual Action Groups Editor on page 113. Organize your context actions into groups.

• Contextual Actions Editor on page 115. Manage the context actions available in the SOA Systinet UI.

• Navigation Actions Editor on page 116. Manage the navigation links available in SOA Systinet.

• Portlets Definitions Editor on page 118. Manage the portlets available in SOA Systinet.

• Perspectives Editor on page 117. Customize the perspectives available in SOA Systinet.

• Taxonomies Editor on page 119. Customize the taxonomies available in SOA Systinet.

• project.xml Editor on page 120. Manage your extension project.

• Messages View on page 123. View the action log as you customize your extension project.

• Search View on page 124. View the results of usage and entity searches.
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Artifact Editor
Artifacts are the basic building blocks of SOA and represent all types of entity. This editor allows you to
modify the parameters, properties and appearance of an artifact type within SOA Systinet. Each artifact
type and package has an editor with the artifact name as the title containing five tabs described in the
following sections:

• Artifact – General Tab on page 91. The main attributes of the artifact type

• Artifact – Properties Tab on page 93. The properties of the artifact type

• Artifact – Service Catalog UI Tab on page 95. The format of the View Artifact page in the SOA
Systinet UI

• Artifact – Tools UI Tab on page 98. The format of the View Artifact and Browse Artifact pages in
the SOA Systinet UI

• Artifact – Registry Mapping Tab on page 101. The mapping of the artifact to registry entities
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Artifact – General Tab

The General tab displays the general attributes of the artifact and allows you to modify some of them:

Figure 1. Business Service Editor – General Tab
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The general tab contains five segments:

• Artifact General Information. There are eight parameters related to artifacts shown in this segment.
They are described in the table below:

DefinitionParameter

The identifier for the resource in the configurationURI

The name of the artifact as it appears in the SOA Systinet UIDisplay Name

The name of the artifact as it is stored in the extensionLocal Name

The plural version of the name as it appears in the SOA Systinet UICollection Display
Name

The parent artifact type that this artifact type belongs toPackage

The artifact type that this artifact type inherits the properties ofExtends Type

The description of the artifact type as it appears in the SOA Systinet UIDescription

A checkbox indicating whether the artifact is currently active in the extensionDeprecated

A checkbox indicating whether the artifact is an artifact package which does not
have actual instances in the repository

Abstract

• Visible to. A simple list of perspectives with Add and Remove functionality to select which perspectives
can see this artifact type within SOA Systinet.

• Editable by. A simple list of perspectives with Add and Remove functionality to select which
perspectives can amend this artifact type within SOA Systinet.

• Properties. A summary of the different properties that the artifact has. Each of the links opens the
Properties tab described in Artifact – Properties Tab on page 93.

• User Interface. A pair of links to the Service Catalog UI and Tools UI tabs where the appearance of
the artifact in the SOA Systinet UI can be amended.
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Artifact – Properties Tab

The Properties tab displays all the properties of the artifact and enables you to add and remove them:

Figure 2. Business Service Editor – Properties Tab

This tab contains into three segments:

• Properties. This is the list of individual properties of the artifact. On the right are five buttons:

• New opens the New Property dialog described in Creating a New Property on page 52.

• Add adds a property to the artifact type from the list of available property descriptors, set its
cardinality, and its location on the View Artifact page.

• Deprecate deactivates the property in the artifact type.
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• Undeprecate reactivates the property in the artifact type.

• Remove removes the selected property from the artifact type.

• Property Groups. This is the list of the property groups of the artifact. On the right are three buttons:

• New opens the New Property Group dialog described in Creating a New Property Group on page
63

• Add adds a property group to the artifact type from the list of available property groups.

• Remove removes the selected property group from the artifact type.

• Inherited Groups and Properties. If the artifact is based on another artifact then this segment displays
the inherited artifact and its properties and groups.

There are three parameters related to properties shown in these segments:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIName

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Which extension this property is part ofExtension
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Artifact – Service Catalog UI Tab

The Service Catalog UI tab displays all the attributes of the artifact as they appear in the Service View
page of the Service Catalog in SOA Systinet and allows them to be amended:

Figure 3. Business Service Editor – Service Catalog UI Tab

There is a checkbox to control whether the artifact is available within the Service Catalog and if this is
checked there are two segments to control its appearance:

• Layout. This is the list of elements and properties of the artifact as they appear in the Service View
page in the Service Catalog. The elements are organized into groups that match the sub-headings on the
Service View page. On the right are five buttons:

• Up moves the element up in the Service View page.

• Down moves the element down in the Service View page.
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• Add adds a property, component or layout group to the Service View page as described in Modifying
the Layout of the View Artifact Page on page 41.

• Edit enables you to edit the name of a sub-heading group or the editable by and visible to attributes
of a property.

• Remove removes the element from the Service View page.

There are five parameters related to page elements shown in this segment:

DefinitionParameter

The name of the page element as in appears in the SOA Systinet UIName

The type of page element with options:

• Property is a property of the artifact type

• Component is a SOA Systinet UI component

• Relationship is a relationship property of the artifact type

Type

The perspectives that can see this page elementVisible to

The perspectives that can edit this page element in SOA SystinetEditable by

Which extension this property is part ofExtension

• Contextual Actions. These are the options that appear in the context action menus at the top of the
Service View page. There are five buttons on the right:

• Up moves the action up in the list.

• Down moves the action down in the list.

• Add adds a new context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 44.

• Edit enables you to edit the context action with the same parameters as Add functionality.

• Remove removes the action from context action menus.
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There are four parameters related to properties shown in this segment:

DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

Contextual action identification in the extensionAction

The perspectives that can see this actionVisible to

Which extension this property is part ofExtension
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Artifact – Tools UI Tab

The Tools UI tab displays all the attributes of the artifact as they appear in the View Artifact and Browse
Artifact pages in Tools in SOA Systinet and allows them to be amended:

Figure 4. Business Service Editor – Tools UI Tab

There are two segments to control its appearance:

• Layout. This is the list of elements and properties of the artifact as they appear in the View Artifact
page in Tools. The elements are organized into groups that match the sub-headings on the View Artifact
page. On the right are five buttons:

• Up moves the element up in the View Artifact page.

• Down moves the element down in the View Artifact page.
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• Add adds a property, component or layout group to the View Artifact page as described in Modifying
the Layout of the View Artifact Page on page 41.

• Edit enables you to edit the name of a sub-heading group or the editable by and visible to attributes
of a property.

• Remove removes the element from the View Artifact page.

There are five parameters related to page elements shown in this segment:

DefinitionParameter

The name of the page element as in appears in the SOA Systinet UIName

The type of page element with options:

• Property is a property of the artifact type

• Component is a SOA Systinet UI component

• Relationship is a relationship property of the artifact type

Type

The perspectives that can see this page elementVisible to

The perspectives that can edit this page element in SOA SystinetEditable by

Which extension this page element is part ofExtension

• Contextual Actions. These are the options that appear in context actions at the top of artifact pages. In
the Tools UI tab there are two tabs in this segment. Artifact Detail shows the actions for the View
Artifact page and Collection shows the actions for the Browse Artifact page. There are five buttons
on the right:

• Up moves the action up in the list.

• Down moves the action down in the list.

• Add adds a new context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 44.
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• Edit enables you to edit the context action with the same parameters as Add functionality.

• Remove removes the action from context action menus.

There are four parameters related to context actions shown in this segment.

DefinitionParameter

The name of the action as it appears in the SOA Systinet UIDisplay Name

Contextual action identification in the extensionAction

The perspectives that can see this actionVisible to

Which extension this context action is part ofExtension
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Artifact – Registry Mapping Tab

The Registry Mapping tab displays any mappings between the artifact and entities in registries and allows
you to create, edit and remove them:

Figure 5. Business Service – Registry Mapping Tab

It is split into two segments:

• Artifact Mapping. This is the list of registry entities that represent the artifact in registries. On the right
are three buttons:

• Add adds a registry mapping as described in Mapping an Artifact Type to a Registry on page 47.

• Edit edits the mapping as described in Mapping an Artifact Type to a Registry on page 47.

• Remove removes the mapping from the artifact.
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There are five parameters related to registry mappings shown in this segment:

DefinitionParameter

The registry that the artifact type is mapped toRegistry Name

The taxonomy key used to categorize the UDDI entity in the registryTModel Key

The name used to categorize the UDDI entity in the registryKey Name

The value used to categorize the UDDI entity in the registryKey Value

Which extension this mapping is part ofExtension

• Property Mappings. This is the list of the properties of the artifact and if they are mapped to a registry.
On the right are three buttons:

• Add adds a new registry mapping for the selected property as described in Mapping an Artifact
Type to a Registry on page 47.

• Edit edits a property mapping as described in Mapping an Artifact Type to a Registry on page 47.

• Remove removes a mapping from the selected property.

There are five parameters related to properties shown in this segment:

DefinitionParameter

The name of the propertyProperty Name

The registry that the artifact type property is mapped toRegistry Name

The taxonomy key used to categorize the UDDI entity in the registryTModel Key

The name used to categorize the UDDI entity in the registryKey Name

Which extension this property is part ofExtension
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Property Editor
Properties are attributes of artifacts. The property editor allows you to modify the properties in your extension
project. Each property has an editor with the property name as the title containing two tabs described in the
following sections:

• Property – General Tab on page 103. The main attributes of the property

• Property – Advanced Tab on page 105. The advanced attributes of the property

Property – General Tab

The General tab displays the general attributes of the artifact and enables you to modify some of them:

Figure 6. Description Editor – General Tab
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This tab contains four segments:

• General. There are seven parameters related to properties shown in this segment:

DefinitionParameter

The name of the property as it appears in the SOA Systinet UIDisplay Name

The name of the property as it is stored in the extensionLocal Name

The identifier for the resource in the configurationURI

The description of the property as it appears in the SOA Systinet UIDescription

The plural version of the name as it appears in the SOA Systinet UICollection Display
Name

A checkbox indicating whether the property is currently active in the extensionDeprecated

• Property Type, Relationship, or Taxonomy. There are three types of property and this segment is
specific to each:

• Property Type. The property type for primitive properties.

• Relationship. This segment displays the source and target artifacts that this relationship links and
some parameters of the inverse relationship. On the right are two sets of two buttons for altering the
source and target artifacts:

• Add selects an artifact in the extension to source or target.

• Remove removes the relationship from a source or target artifact.

• Taxonomy. The taxonomy that contains the available options for this property with Browse to select
a new taxonomy from the extension project.

• Visible to. A list of perspectives with Add and Remove functionality to select which perspectives can
see this property within SOA Systinet.

• Editable by. A simple list of perspectives with Add and Remove functionality to select which
perspectives can amend this property within SOA Systinet.
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Property – Advanced Tab

The Advanced tab displays the advanced attributes of the property and allows you to modify them:

Figure 7. Description Editor Advanced Tab
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This tab contains three segments:

• Cardinality. There are three parameters related to property cardinality shown in this segment:

DefinitionParameter

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

If a property has multiple cardinality this parameter is the minimum occurrences of
the property in an artifact

MinOccurs

If a property has multiple cardinality this parameter is the maximum occurrences of
the property in an artifact. Use unbounded if there is no limit.

MaxOccurs

• Default Values. There are two parameters related to properties shown in this segment:

DefinitionParameter

An XML extract defining the default valueDefault Value

An XML extract defining default values in the case of multiple cardinalityMultiple Default
Value

• Database Sizes displays optional database sizing for property elements with Add, Edit and Remove
functionality.
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Property Group Editor
Properties can be organized into groups. The property group editor allows you to add and remove properties
from a property group. Each property group has an editor with the property group name as the title:

Figure 8. System Properties Editor

The editor contains two collapsible segments:

• General enables you to change the Display Name and URI of the property group.

• Properties enables you to manage the property group.

On the right are three buttons:

• New creates a new property as described in Creating a New Property Group on page 63.

• Add adds a property to the group from the list of available properties.

• Remove removes the selected property from this property group.
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There are three parameters related to properties described in the table below:

DefinitionParameter

The name of the propertyName

The occurrence of the property in an artifact with options:

• Optional. The property is not required to be populated

• Required. The property must be populated

• Multiple. The property can occur multiple times with different values

Cardinality

Which extension this property is part ofExtension
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Navigation Editor
Navigation actions are the links between pages in SOA Systinet. The navigation editor allows you to
configure the left menu and title of SOA Systinet tabs:

Figure 9. Dashboard Navigation Editor

The editor contains two collapsible segments:

• General enables you to change the Display Name and Description of the SOA Systinet tab.

• Menu enables you to configure the left menu of the SOA Systinet tab. The navigation items are arranged
into headings and links.

On the right are five buttons:

• Up moves the selected item up in the menu.

• Down moves the selected item down in the menu.

• Add contains three options:
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Item adds a navigation item to the menu as described in Adding Navigation Actions to a SOA
Systinet Tab on page 69.

•

• Component adds a component to the menu as described in Adding Components to a SOA
Systinet Tab on page 71.

• Group adds a new heading to the menu as described in Adding Navigation Groups to a SOA
Systinet Tab on page 68.

• Edit opens one of three edit dialogs depending on the item selected:

• Item edits a navigation item with the same parameters described in Adding Navigation Actions
to a SOA Systinet Tab on page 69.

• Component edits a component with the same parameters described in Adding Components to
a SOA Systinet Tab on page 71.

• Group edits a menu heading with the same parameters described in Adding Navigation Groups
to a SOA Systinet Tab on page 68.

• Remove removes the selected navigation item from the SOA Systinet tab menu.

There are five parameters related to context actions in this segment:

DefinitionParameter

The name of the navigation item as it is stored in the extensionName

The identification of SOA Systinet UI task invoked by this menu itemTask Location

Item or ComponentType

Which perspectives can see this itemVisible to

Which extension this navigation item is part ofExtension

Chapter 7110



Portlets Editor
There is a separate portlets editor for each tab within SOA Systinet. These allow you to control which
portlets are available in each tab and where they appear.

Figure 10. Dashboard Portlets Editor

On the right are three buttons:

• Add opens the New Portlet Placement dialog described in Adding Portlets to a SOA Systinet Tab on
page 66.

• Edit opens the Edit Portlet Placement dialog for the selected portlet with the same parameters described
in Adding Portlets to a SOA Systinet Tab on page 66.

• Remove removes the selected portlet from the SOA Systinet tab.
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There are five parameters related to portlet placement:

DefinitionParameter

The identification of the portlet in the extensionPortlet Reference

The name of the portlet as it appears on the SOA Systinet tabPortlet Display
Name

There are two options:

• page. The portlet is open in the main area of the SOA Systinet tab

• menu. The portlet is closed but available to add in the left menu

Location Name

If the portlet is open this specifies which column it appears in on the SOA Systinet
tab

Area

Which extension this portlet is part ofExtension
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Contextual Action Groups Editor
Context actions can be grouped in order to add many actions to a UI element at once. The contextual action
groups editor allows you to create, edit and remove context action groups from your extension project:

Figure 11. Contextual Action Groups Editor

On the right are three buttons:

• Add contains two options:

• Action Item adds a context action to a group as described in Adding Context Actions to a Group
on page 77.

• Group of Contextual Actions adds a new context action group as described in Creating a New
Context Action Group on page 76.

• Edit has two functions depending on which item in the editor is highlighted:

• For a group you can edit the name.

• For an item the Edit Item dialog is opened as described in Modifying a Contextual or Navigation
Action on page 75.
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• Remove deletes the selected context action item from your extension project.

There are four parameters related to context actions:

DefinitionParameter

The name of the action group as it is stored in the extensionName

The reference to the contextual action in the extensionAction

Which perspectives can see this itemVisible to

Which extension this perspective is part ofExtension
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Contextual Actions Editor
Context actions are options available in the SOA Systinet UI for artifact and service pages. The contextual
actions editor allows you to create, edit and remove context actions from your extension project:

Figure 12. Contextual Actions Editor

On the right are three buttons:

• New opens the New Action dialog described in Creating a New Contextual or Navigation Action on
page 72.

• Edit opens the Edit Action dialog for the selected item as described in Modifying a Contextual or
Navigation Action on page 75.

• Remove deletes the selected context action from your extension project.
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There are three parameters related to context actions:

DefinitionParameter

The name of the context action as it is stored in the extensionName

The reference to the contextual action in the extensionAction

Which extension this perspective is part ofExtension

Navigation Actions Editor
Navigation actions are the links available in the menus of SOA Systinet tabs. The navigation actions editor
allows you to create, edit and remove navigation actions from your extension project:

Figure 13. Navigation Actions Editor

On the right are three buttons:

• New opens the New Action dialog described in Creating a New Contextual or Navigation Action on
page 72.
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• Edit opens the Edit Action dialog for the selected item as described in Modifying a Contextual or
Navigation Action on page 75.

• Remove deletes the selected navigation action from your extension project.

There are three parameters related to context actions described in the table below:

DefinitionParameter

The name of the navigation action as it is stored in the extensionName

The identification of SOA Systinet UI task invoked by this menu itemTask Location

Which extension this perspective is part ofExtension

Perspectives Editor
Perspectives are the way SOA Systinet controls what users can view. The perspectives editor allows you
to create, edit and remove perspectives from your extension project:

Figure 14. Perspectives Editor

On the right are three buttons:

• New opens the New Perspective dialog described in Creating a New Perspective on page 79.

• Edit opens the Edit Perspective dialog for the selected perspective with the same parameters described
in Creating a New Perspective on page 79.
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• Remove deletes the perspective from your extension project.

There are four parameters related to perspectives:

DefinitionParameter

The name of the perspective as it is stored in the extensionName

The name of the perspective as it appears in the SOA Systinet UIDisplay Name

The description of the perspective as it appears in the SOA Systinet UIDescription

Which extension this perspective is part ofExtension

Portlets Definitions Editor
Portlets are the components that appear in the main area of SOA Systinet tabs. The portlets definitions editor
allows you to add, edit and remove portlet definitions from your extension project:

Figure 15. Portlets Definitions Editor

On the right are three buttons:

• Add contains two options:

• Feed adds a new RSS feed portlet as described in Creating a New RSS Feed Portlet on page 81.
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• Portlet adds a new portlet as described in Creating a New Portlet on page 80.

• Edit opens the Edit Feed or Edit Portlet dialog for the selected item with the same parameters as Add
functionality.

• Remove deletes the selected portlet from your extension project.

There are five parameters related to portlets described in the table below:

DefinitionParameter

The name of the portlet as it is stored in the extensionName

The type of portlet with options:

• Feed

• Portlet

Type

The identifier for the resource with portlet dataURI

The SSO partner identificationPartner

Which extension this perspective is part ofExtension

Taxonomies Editor
Taxonomies are category groups that allow you to organize your services. The taxonomies editor allows
the import and removal of taxonomies from your extension project:
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Figure 16. Taxonomies Editor

On the right are two buttons:

• Import imports taxonomies from the active SOA Systinet server.

• Update refreshes the taxonomy list with any changes from the SOA Systinet server.

• Remove deletes the selected taxonomy from the extension project.

There are three parameters related to context actions described in the table below:

DefinitionParameter

The name of the taxonomy as it is stored in the extensionName

The taxonomy key identifierTModel Key

Which extension this taxonomy is part ofExtension

project.xml Editor
The project editor allows you to configure your extension project. It contains three tabs described in the
following sections:

• Project – Overview Tab on page 121
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• Project – Environment Tab on page 122

• Project – Dependencies Tab on page 123

Project – Overview Tab

The Overview tab enables you to view and amend the basic parameters of your extension project:

Figure 17. Project Overview Tab

The tab contains two collapsible segments:

• Project details displays parameters for the extension project:

DefinitionParameter

The name of the extension projectProject name

The project is an extension projectProject type

The workspace folder that contains the extension projectProject location

The last time the project was changedLast modified

• Extension details enables you to configure some of the extension project parameters:
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DefinitionParameter

The display name of the extensionName

The version number of the extension projectVersion

A description of the extension projectDescription

The identifier for the resource in the configuration (not editable)URI

The prefix used for the URI when you create a new artifact type or propertyNamespace

Project – Environment Tab

The Environment tab enables you to change the parameters of the SOA Systinet server that the Customization
Editor is configured for:

Figure 18. Project Environment Tab

The tab contains the parameters:

DefinitionParameter

The location of the extension folder in your SOA Systinet installationServer Installation
Folder

The URL used to access SOA SystinetServer URL
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Project – Dependencies Tab

The Dependencies tab displays general information about your extension project and any dependencies
that is has:

Figure 19. Project Dependencies Tab

The tab contains two segments:

• Extension dependencies displays a tree of extensions that the extension project is dependent on.

• Project and extension general information displays parameters of the extension project:

DefinitionParameter

The name of the extensionName

The version number of the extension projectVersion

A description of the extension projectDescription

The identifier for the resource in the configuration (not editable)URI

The creation date and time of the extensionBuildtime

Messages View
The Messages view tracks the changes that you make to extension entities and displays any warnings and
problems that may occur as a result of those actions:
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Figure 20. Messages View

Double-clicking an item in the tree opens the relevant editor for that object.

Search View
The Search view displays the results of a search (see Searching the Extension on page 30) or find usage
query (see SDM Details on page 27):

Figure 21. Search View

The results are shown as a tree of artifact types, properties and property groups containing the requested
item.

Double-clicking an artifact type, property or group opens the relevant editor.
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